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Long Abstract 
 

Video tracking systems have been used widely to analyze Drosophila melanogaster 

movement and detect various abnormalities in locomotive behavior. While these systems 

can provide a wealth of behavioral information, the cost and complexity of these systems 

can be prohibitive for many labs. We have developed a low-cost assay for measuring 

locomotive behavior and seizure movement in D. melanogaster. The system uses a web-

cam to capture images that can be processed using a combination of inexpensive and free 

software to track the distance moved, the average velocity of movement and the duration 

of movement during a specified time-span. To demonstrate the utility of this system, we 

examined a group of D. melanogaster mutants, the Bang-sensitive (BS) paralytics, which 

are 3-10 times more susceptible to seizure-like activity (SLA) than wild type flies. Using 

this novel system, we were able to detect that the BS mutant bang senseless (bss) exhibits 

lower levels of exploratory locomotion in a novel environment than wild type flies. In 

addition, the system was used to identify that the drug metformin, which is commonly 

used to treat type II diabetes, reduces the intensity of SLA in the BS mutants.  

 

Introduction 

 

Given its short lifespan and the robust genetic tools available, Drosophila melanogaster 

is an excellent model system for investigating the etiology of various diseases and the 

underlying physiology of various biological processes. In many cases, it is advantageous 

to measure the effects that behavioral, genetic or pharmacological manipulations have on 

locomotion in these model organisms.
1,2

  

 

There are a variety of methods that are commonly used for measuring fly movement in 

two-dimensions.
3,4,5,6,7

 These systems can support the tracking of multiple flies 

simultaneously and can measure velocity, record path lengths and record the percentage 

of time a fly has spent moving. They have been used to study movement in a variety of 

contexts including the effects of drugs on locomotion and the sexual dimorphic nature of 

fly movement.
6,7,8,9

 The major drawback of these systems is cost of the tracking system or 

the corresponding software and camera. In some cases, this can run in the thousands of 

dollars. Cost is a particular concern for a lab that would only need limited use of such a 

system, for example, quantifying locomotive patterns of a newly isolated mutant.  

 

A simpler but less robust method is to use systems which record movement based on how 

many times a fly crosses an infrared light beam path that is placed in the middle of a 

closed tube.
10,11

 While such systems can give valuable information on movement and 

sleep-wake cycles, they can over or under estimate movement because they fail to capture 

the actual path of the fly. For example, flies that exhibit considerable movement at the 

ends of the tube will register as low movement flies although additional high-resolution 

methods have been used to try and circumvent these limitations.
12

 

 

Simpler and cheaper still are climbing devices that measure geotaxis, the upward 

movement of flies, through a single tube or a series of tubes.
2,13

 While such systems are 



cheap and can easily identify geotaxis defects, they fail to capture many other aspects of 

movement that would be of interest to investigators.  

 

For many labs, a low-cost robust analysis system that is simple to set-up and operate 

would be an advantageous tool for characterizing behavioral differences in D. 

melanogaster strains. Here we describe an assay that can be set-up for less than two 

hundred dollars and is able to give information about the path, velocity and duration of 

the fly’s movement. To demonstrate the efficacy of the assay, we present data showing 

that it can be used to identify; 1) a locomotor defect in a Bang-sensitive (BS) mutant that 

is susceptible to seizures and 2) the ability of the drug metformin, which is commonly 

used to treat type II diabetes, to reduce the intensity of seizure-like activity (SLA) in two 

BS mutants. 

 

  



Protocol Text: 

 

1.  Preparation of Individual Flies for Locomotion Assay 

 

1.1) Transfer flies by gently tapping into individual empty vials and cap the vials with a 

cotton plug. Allow flies to sit undisturbed 20-30 minutes before observation. It is 

important to not anesthetize the flies within the hours prior to behavioral observation as 

previous studies have found anesthesia exposure can alter behavior as compare to 

unanesthesized flies.
14

 

 

1.2) Gently tap the flies out of the vials and place individual flies under a 5 cm diameter 

petri dish cover (5 mm high) with small slits to allow air passage. Illuminate from below 

and observe the flies using a webcam mounted above the petri dish.  

 

2.  Preparation of Individual Flies for Seizure Assay 

 

2.1) Feed two-day old seizure sensitive flies either standard yeast/cornmeal/agar media or 

standard media mixed directly with drug. For the data presented here, flies were fed 

either 1 gram of standard media or 1 gram of standard media mixed with 25 mg of 

metformin.  

 

2.2) After the flies have fed for two days on the media or media plus drug, transfer them 

by gentle tapping into individual empty vials and cap the vials with a cotton plug. Allow 

flies to sit undisturbed for 20 minutes before observation. It is important to not 

anesthetize the flies within the hours prior to behavioral observation as previous studies 

have found anesthesia exposure can alter behavior as compare to unanesthesized flies.
14

 

 

2.3) Vortex individual vials containing a single fly on a lab vortexer using the highest 

setting for 10 seconds. Place the immobilized fly on a blank white sheet of paper directly 

below a webcam mounted above the paper. 

 

3. Video Recording 
 

3.1) Record the movement or SLA using the HandyAvi software program 

http://www.azcendant.com/download.htm. This program uses the webcam to capture 

images based upon the user settings.  

 

3.2) Select the Time-Lapse images option under the Capture tab, When the window 

opens, select the webcam as the capture device.  For most experiments the video frame 

size of 640 x 400 is adequate.  

 

3.3)  Select Intel IYUV codec for the compression and choose 0.1 seconds per frame for 

the seizure assay or choose 0.1 to 0.5 second per frame for the movement assay. Under 

the advanced tab, select create a .bmp image file for each capture and select a folder for 

the program to store the images that it takes (the image stack).  

 

http://www.azcendant.com/download.htm


3.4) Place a dead fly on the sheet of paper. Click on the Video settings box and adjust the 

settings under the Device settings tab so that there is a bright white background and a 

clear contrast with the darker fly.   

 

3.5) Click the start button to begin the recording. Once the recording period has finished, 

click the stop button. The image stack should now be in the folder selected. Note: Before 

recording, ensure that the folder selected for the image stack is empty. 

 

4. Data Analysis Using ImageJ 
 

4.1) Open NIH’s free image processing software ImageJ, which can be downloaded at 

http://rsbweb.nih.gov/ij/download.html. Note: In addition to downloading the program, 

the Multitracker plug-in must be downloaded and installed as indicated at 

http://rsbweb.nih.gov/ij/plugins/index.html.  

 

4.2) Import the image stack into ImageJ by clicking on the File tab and then selecting 

Import  Image sequence.  

 

4.2.1) Select the folder that contains the image stack, highlight one of the images and 

select open. A Sequence Options dialogue box will open. Click the Sort names 

numerically and then select OK and the image stack will be loaded into ImageJ.   

 

4.3) Threshold all the images so that each consists of a white background with the fly 

being converted to a black dot. To do this, convert the image to an 8-bit format by 

selecting Type 8 bit under the Image tab.  

 

4.3.1) Click on the Image tab again and select AdjustThreshold. This will open the 

Threshold dialogue box in which the threshold cut off point can be adjusted.  

 

4.3.2) Scan through the images to see if there are extra black dots or if a slice lacks a 

black spot. If this is the case, adjust the threshold to alleviate the problem. Usually the 

threshold does not need to be adjusted as the program defaults to an adequate value. 

Note: Every slide in the stack should have just one black dot representing the position of 

the fly. 

 

4.3.3) Select apply in the Threshold dialogue box and a Convert to Mask dialogue box 

will open. Do not click any of the options but simply click OK to threshold the image 

stack. 

 

4.4) After thresholding the image stack, select the Multitracker plug-in under the Plugins 

tab in order to measure the movement of the fly in pixels. The Object Tracker dialogue 

box will appear.  

 

4.4.1) Click all of the four options given in the dialogue box and then select OK. The 

Multitracker plug-in will then attach coordinates to the black dot in each slice and list 

http://rsbweb.nih.gov/ij/download.html
http://rsbweb.nih.gov/ij/plugins/index.html


these in the Results window as well as the total path length in pixels. The Paths window 

gives a graphical display of the path the fly took.  

 

4.4.2) Copy the X and Y coordinate list from the Results window and paste the data into 

an Excel spreadsheet. If any slide in the stack does not have a black dot in it, the 

Multitracker program will halt at that slide. If this occurs, it is necessary to go back to 

step 4.3 and re-threshold the stack to ensure that the fly registers as a black dot in the 

slide in question.  

 

4.5) In order to convert the path lengths from pixels to cms, take a separate image of two 

dots that are spaced one cm apart on a blank white piece of paper.  

 

4.5.1) Follow the above steps (3.1-4.4.2), to determine the X,Y pixel coordinates for the 

two dots and use this information to determine the number of pixels corresponding to a 

cm. This conversion factor is used in step five to generate movement data in cms. Note: 

Once this is done, it is important to keep the camera fixed for all future recordings. Every 

time the camera is moved or adjusted, one needs to repeat this step to convert the pixels 

to cms.  

 

4.5.2) The path length that is generated by the Multitracker plug-in overestimates 

movement because slight fluctuations in body position and light intensity/reflection will 

affect the size and center of the black dot that is generated when thresholding the images. 

This noise must be removed in order to get an accurate estimation of fly movement.   

 

5. Data Analysis Using Excel 
 

5.1) Remove the noise from the recorded data by importing the series of X,Y coordinates 

generated by the Multitracker program into Fly Analysis, an Excel Visual Basic program 

created by the authors. (The program is available by contacting the authors.)  

 

5.2) Click the Click Me button and select a threshold value cut-off. Select a threshold 

value of 0.5 cm/sec for SLA analysis or select a value between 0.1 and 0.3 cm/sec for 

movement analysis. Click OK and the program will calculate the velocity, time and 

distance of movement. Note: The program uses a sliding window analysis to evaluate the 

data in sequential 0.5-1.0 sec bins and calculates the velocity during that window. 

Anything above the user-defined cut-off is treated as fly movement.  

 

  



Representative Results 

 

The technique described here has been used previously to analyze differences in SLA in 

the Drosophila BS mutants.
1
 The results presented here involve the BS strains easily 

shocked (eas), bang senseless (bss), and technical knockout (tko). The eas locus encodes 

an ethanolamine kinase involved in phosphatidyl ethanolamine synthesis
15

 and the tko 

locus encodes a mitochondrial riboprotein.
16

 The bss mutation is an allele of the paralytic 

(para) voltage-gated sodium channel.
17

 The alleles used in this study were eas
1
, bss

1
 and 

tko
25t

.   

 

An illustration of the efficacy of the method to measure SLA can be seen in Figure 1, 

which depicts the path length of a eas seizure-sensitive control fly as compared to one 

that has been fed the drug metformin. Metformin is a biguanide used to treat type II 

diabetes. The drug inhibits mitochondrial respiratory chain complex I, which, via the 

upregulation of AMPK, triggers an increase in glycolysis and glucose uptake in 

mammalian cells.
18

 Previous studies have found that metformin upregulates glycolytic 

genes, presumably to compensate for the inhibition of aerobic metabolic pathways.
19

 

Figure 2 demonstrates that feeding the BS mutants eas and tko metformin for two days 

(25mg/g of food) reduces the SLA path length.  

 

In addition to reducing the path length, the data generated by this method can be used to 

analyze differences in SLA velocity and SLA duration.  In this case, the data indicate that 

SLA duration was significantly reduced (Figure 3) while SLA velocity was not changed 

significantly (Figure 4). 

 

The assay described above can also be used to measure locomotion over a defined period 

of time. Figure 5 shows an example of a path traversed by a wild type Canton-Special 

(CS) fly and a path traversed by a bss fly over a period of fifteen minutes. While the 

movement of both flies was concentrated at the edges of the circular area, the CS fly 

exhibited much more locomotion over the fifteen-minute recording period. The assay is 

therefore useful in looking at both the amount of movement and the pattern of movement 

of the flies. 

 

The average distance traversed by bss flies was significantly lower than that of CS flies 

as indicated by Figure 6. Not only did the bss flies display less movement, they tended to 

move with a slower velocity. Changes in the velocity of movement of two individual flies 

are depicted in Figure 7. Using this data, an average velocity can be calculated and 

compared as in Figure 4 for SLA. Based on the representative flies shown in Figure 7, it 

is apparent that the CS flies had more frequent bouts of fast movement while the bss flies 

had more bouts of inactivity during the period represented in the figure.  

 

Figure Legends 

 

Figure 1: Representative paths of SLA in eas mutants and eas mutants fed metformin. 

Individual flies were mechanically shocked to induce SLA. The path of an individual fly 



during the SLA is represented in the figure. A) Path of an eas mutant. B) Path of an eas 

mutant fed metformin. (Bar represents 1 cm) 

 

Figure 2: Individual flies were mechanically shocked to induce SLA. The distance the 

fly moved during the SLA was used as a measure of SLA intensity. In both BS mutants 

examined, metformin significantly reduced the distance moved. Data was analyzed using 

the Mann-Whitney U test. (*p < 0.05; ***p < 0.001; n = 15)  

 

Figure 3: A) Individual flies were mechanically shocked to induce SLA. The time the fly 

spent undergoing SLA was used as a measure of SLA intensity. In both BS mutants 

examined, metformin significantly reduced the SLA duration. Data was analyzed using 

the Mann-Whitney U test. (*p < 0.05; ***p < 0.001; n = 15)  

 

Figure 4: A) Individual flies were mechanically shocked to induce SLA. The average 

velocity of the fly during the bout of SLA was used as a measure of SLA intensity. There 

was no significant change in average velocity for the two BS mutants tested when fed 

metformin. Data was analyzed using the Mann-Whitney U test. (n = 15) 

 

Figure 5: Paths of individual flies in the arena. Traces represent the paths individual flies 

traversed in the arena during the 15-minute monitoring period. A) Path of an active CS 

fly with the movement concentrated around the periphery of the circular arena. B) Path of 

a typical bss fly. Movement was still concentrated around the periphery but there was 

much less movement as compared to CS flies. (Bar represents 1 cm) 

 

Figure 6: Fly locomotion when exposed to a novel environment. Individual flies were 

placed in a 5cm diameter arena (5mm in height) and movement was monitored for 15 

minutes. Path lengths were calculated for each fly and the average lengths were taken for 

each genotype. The bss mutants displayed a significant reduction in path length as 

compared to CS flies. Data was analyzed using the Mann-Whitney U test. (**p < 0.01; n 

= 10) 

 

Figure 7: Velocity as a function of time during exploratory locomotion for a CS and a 

bss fly. An individual fly was placed in a 5cm diameter arena (5mm in height) and 

movement was monitored for 15 minutes. Velocity was calculated every 0.5 secs by 

averaging the velocity over a one second sliding window (movement from the previous 

0.5 sec to the subsequent 0.5 sec interval.) After a few initial bursts of activity the bss fly 

remains relatively inactive throughout the trial. 

 

Discussion 

 

When examining locomotor or movement patterns in Drosophila, it is useful to be able to 

extract information regarding the distance traveled, the velocity of movement and the 

pattern of movement. In order to extract this information, expensive equipment has 

traditionally been employed that is often prohibitive for smaller labs or labs that wish to 

use such assays sparingly.
4,8,9

 

 



The assay described here can be used to determine the distance traveled (Figure 2 and 

Figure 6), the velocity of the movement (Figure 4 and Figure 7) and the pattern of 

movement (Figure 1 and Figure 5) using equipment that costs less than two hundred 

dollars. Using the Excel Visual Basic program we have developed, the series of X,Y 

coordinates generated by the ImageJ program can be analyzed to extract all this 

information. This system has been used previously to identify both genetic and 

pharmacological suppressors of SLA in the seizure-sensitive Drosophila BS mutants.
1
  

 

While the system can extract valuable information, we have only analyzed one fly at a 

time. This can be a significant drawback as compared to the highly parallel commercial 

options.
4
 The Multitracker plug-in for ImageJ does have the ability to track multiple 

objects simultaneously but we have not tried this option. For this locomotor assay, a 

single fly is placed under a plastic petri dish lid. Depending on the position of the camera, 

one could film multiple petri dishes to do parallel recordings. The drawback is that the 

resolution will decrease as the web camera is positioned to take in a larger field. How this 

affects the integrity of the recording is not known, but a higher end camera would be an 

option if one wanted to pursue parallel recordings.  

 

The recordings done here are limited to 15 minutes but it is possible to do longer 

recordings if one employs the 64-bit version of ImageJ. The 32-bit version has a memory 

limit that restricts the size of the files one can analyze. For longer recordings, it is 

essential to use the 64-bit version of ImageJ.  

 

One of the biggest issues regarding this method is the need to remove the noise from the 

data generated by processing it in the ImageJ software. However, this is not unique to this 

method as similar noise issues must be resolved with other recording options.
3,5,6,8

 As 

discussed in the methods, a stationary fly may display minor amounts of movement when 

processed through ImageJ because the program measures movement from the center of 

the object, which can vary even in a stationary object due to fluctuations in light and fly 

posture.  

 

Our Visual Basic Excel program uses a sliding window analysis to set a threshold for 

movement. This threshold may vary depending on the assay. For seizure analysis, the 

sliding window looks at ten recording points, which spans one second of real time. If the 

fly has moved 0.5 cm or more during this time it is considered to be actively seizing. If it 

is less, it is considered to be at rest. When looking at normal movement, a lower 

threshold is needed to determine the cut off and this has to be achieved via trial and error. 

A threshold of 0.1cm/sec was used in this study. The best way to achieve this is to record 

a fly while it is stationary for a brief period of time and then adjust the cut off so that it 

indicates no movement during the recording.  

 

In summary, this low-cost method represents a viable assay for extracting meaningful 

information regarding the various parameters of fly locomotion. It is an ideal screening 

technique to use to identify if a behavioral, genetic or pharmacological manipulation has 

an effect on locomotion or seizure susceptibility.  
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Name of the Reagent/Equipment Company Catalog Number/Model

WebCam Logitech Pro900

HandiAVI time-lapse software Azcendant software

ImageJ NIH

Multiracker Plug-In NIH

Vortexer VWR Vortex Genie 2

5cm petri dish cover LabM Limited D011

Light box Built from scrap material.
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Comments

Any quality webcam will suffice.

Latest version can be found at http://www.azcendant.com/

Latest version can be found at http://rsbweb.nih.gov/ij/download.html

Latest version can be found at http://rsbweb.nih.gov/ij/plugins/index.html

Most standard size vortexers such as the Vortex Genie 2 will suffice.

Smaller or larger petri dish covers can be used for an arena in movement assay.

Illumination is used for the locomotion assay. Depending on the room lighting, it is possible to perform the assay without the light box. 



Illumination is used for the locomotion assay. Depending on the room lighting, it is possible to perform the assay without the light box. 
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Editorial comments: 
 

*Please make sure that your references comply with JoVE instructions for authors.  

-In-text formatting: corresponding reference numbers should appear as superscripts after the appropriate 

statement(s) in the text of the manuscript. Please revise the formatting in the representative results section. 

-Citation formatting should appear as follows: (For 6 authors or less list all authors. For more than 6 

authors, list only the first author then et al.): [Lastname, F.I., LastName, F.I., LastName, F.I. Article Title. 

Source. Volume (issue), FirstPage - LastPage, DOI, (YEAR).] 

 

Response: The in-text references have been modified to comply with the instructions. In addition, the 

volume has been set in bold type in the references. 

 

Reviewers' comments: 
 

Reviewer #1:  
Description 

This manuscript describes a technique for describing behavioral movements in Drosophila by video 

tracking. This capability has been valuable for progress in the field of neurogenetics since its earliest days 

of tracking daily rhythms in circadian rhythm movements, and recently in high-speed recordings of escape 

behavior. The attraction of the present manuscript is that it describes methodologies of low-cost video 

tracking allowing for the first time, access to this type of analysis to all laboratories. This is an especially 

attractive notion for teaching laboratories, including high school-level teaching labs. 

 

Critique 

No weaknesses are apparent in the presentation. The methodology is presented in step-by-step detail using 

easily available equipment and software. I especially enjoyed descriptions of the limitations of the 

methodology and ideas about how the methodology might be expanded. 

 

Additional Comments to Authors: 

N/A 

 

 

Reviewer #2:  
Manuscript Summary:  

Overall, the paper is well written and the techinque should be of interest of many in the Drosophila research 

field. The ability to quantify locomoter and seizure behavior is often an expensive undertaking and this 

procotol clearly lays out a technique the mitigates the high cost of such experiments. The authors 

demonstrate the validity of their system using bang sensitive and seizure prone fly lines that have been 

treated with a compound that can improve the neurological phenotypes.  

 

Major Concerns: 

1. For the protocol text, I would add a paragraph describing the type of food used and how the drug was 

administered. Was the food cooked or instant reconsituted food? Did the drug require a vehicle such as 

DMSO? If so then there should be a vehicle only control in the experiments. Was the drug mixed into the 

food or placed on a filter paper on top? This is also where I would move the first mention of the 

concentration of drug administered. 

 

Response: The type of food is now described in the protocol. The drug was mixed directly with the food so 

no vehicle was used. This is described in the text.  

 

Minor Concerns: 

1. I recommend minor changes to the text. I would add the species name when introducing your model 

organism in the Abstract and Introduction. I assume this is Drosophila melanogaster. 

 

Response: This change has been made. 
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2. For the seizure assay, was the fly also under a petri dish? What did you do to prevent the fly from flying 

away?  

 

Response: The fly was not under a petri dish. When these flies finish undergoing seizure-like activity they 

are extremely hypoactive and do not move extensively or fly until well after the recording of the seizure-

like activity has stopped. Covering the fly is not necessary to perform the recording. 

 

3. Statistical analysis description is missing. I would add a paragraph to the methods or add information 

into the text detailing which method was used to determine p values. I am assuming this is the student's t 

test, but it should be stated in the text. 

 

Response: In all cases, the non-parametric Mann-Whitney U test was used to test for statistical significance 

because of the non-normal distribution of the data. This is now indicated in the figure legends. 

 

4. Figure 7 legend text should be changed to say CS instead of wildtype to match the other legendes that 

use CS flies. 

 

Response: This change has been made. 

 

5. Figure 1 and Figure 5, I would add unit of measure to the scale bar and not just state it in the legend. 

 

Response: These changes have been made to the figures. 

 

6. Figure 1, Figure 5, and Figure 7 I would identify the fly type and treatment (if necessary) above each 

data set to make it clear for a reader scanning the paper. I know this is stated in the legend, but adding a 

label to the figure will be of additional help to the reader. 

 

Response: These changes have been made to the figures. 

 

Additional Comments to Authors: 

I would change the text about any vortexer will suffice. Cheap mini vortexers are not sufficient in some 

cases to induce paralysis in some bang sensisitive strains. I would state the model of vortexer you utilized 

for your studies.2 

 

Response: The comments on the Reagents and Supplies for the vortexer has been changed to the 

following: “Most standard size vortexers such as the Vortex Genie 2 will suffice.” 
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